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1. Dulezité

Tato elektronickd uzivatelska prirucka je urcena
pro kazdého uzivatele tohoto monitoru
Philips. Pred pouzivanim monitoru si prectéte
tuto uzivatelskou prirucku. Obsahuje dllezité
informace a pozndmky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po priloZenf origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
nadkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a Udrzba

) Varovani

PouZitf kontrol, Uprav nebo postupt jinym
zpUsobem nez je stanoveno v této dokumentaci
muZe vést k ohrozenf Sokem, elektrickym a/
nebo mechanickym riziklm.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor primému
slunecnimu zdfenl, velmi silnym jasnym
svetldm a udrzujte jej mimo dosah jinych
zdrojt tepla. Dlouhé vystaveni tomuto

typu prostredi mize mit za ndsledek
zménu barev a poskozen{ monitoru.

»  Odstrarite veskeré predmeéty, které by
mohly spadnout do vétracich otvor(
nebo zabranit dostate¢nému chlazenf
elektroniky monitoru.

* Nezakryvejte vétraci otvory ve skiifice.

*  Umistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupnd.

* Jestlize jste vypnuli monitor odpojenim
napdjecfho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normélné.

Vzdy pouzivejte napdjeci kabel schvdleny
spole¢nosti Philips. Pokud napdjeci kabel
chybf, obrat'te se na nejbliz3f servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

Béhem pouzivdni nevystavujte monitor
nadmérnym otresim nebo ndrazim.

Pri pouZivani nebo premistovdnf

do monitoru nekopejte a zabrarite
pripadnému pddu.

Udriba

Aby byl monitor chrdnén prred moznym
poskozenim, nevyvijejte na panel LCD
nadmérny tlak. Pri premistovani zvedejte
monitor za ram; pri zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

Nebudete-li monitor del${ dobu pouZzivat,
odpojte jej ze zdsuvky.

Pred ocisténim mirné navihéenym
hadrfkem monitor odpojte ze z4dsuvky.

Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrfkem. K ¢igténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napriklad alkohol nebo disti¢e s obsahem
¢pavku.

Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozeni
monitoru a chrarite monitor pred prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrante cizf ldtku nebo vodu z
monitoru a odeslete jej do servisniho
strediska.

Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, prfimému
slune¢nimu zéfenf nebo extrémnim
teplotdm.

Chcete-li zachovat optimalni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouzivejte jej na misté, které splfiuje
ndsledujicl rozsahy teplot a vihkosti.



*  Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vihkosti

+  DULEZITE: Pfed ponechanim monitoru
bez dozoru vzdy aktivujte spori¢
obrazovky. Bude-li na vaSem monitoru
zobrazen neménicf se staticky obsah, vzdy
aktivujte aplikaci pro pravidelnou obnovu
obrazovky. Dlouhodobé neprerusované
zobrazeni nehybného nebo statického
obrazu muze zplsobit , vypdlen(*
obrazovky, rovnéz zndmé jako ,,dosvit"
nebo ,,zobrazenf duchd*.

,Vypdleni*, ,,dosvit" nebo ,,zobrazenf
duch(" je dobre zndmy jev u technologie
paneld LCD. V mnoha pripadech
"vypdleni", "dosvit" nebo "zobrazeni duchd"
postupné zmizf po urcité dob& mimo
provoz.

) Vystraha

Pokud neaktivujete sporfi¢ obrazovky nebo
aplikaci, kterd pravidelné obménuje obsah
zobrazeni, mdze dojit k vaznému , vypéleni”,
,dosvitu' nebo , zobrazeni duchd", a toto
naruseni obrazu jiz nelze odstranit. Na vyse
uvedené poskozenf se nevztahuje zaruka.

Servis

e Kryt pldsté mdze otevrit pouze
kvalifikovany servisnf pracovnik.

* Pokud je pro opravu vyzadovédna
dokumentace nebo integrace, obratte se
na nejblizsi servisni stredisko. (Viz kapitola
, Stredisko zdkaznickych informaci™)

* Informace o prevdzeni najdete v dsti
,,Technické udaje".

*  Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

€& Pozniamka

Pokud monitor nefunguje sprdvné nebo pokud
si nejste jisti, jaké kroky je teba provést po
provedeni pokynU v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mlzete narazit na
text, ktery je opatreny symbolem a je vytistén
tucné nebo kurzivou. Takové Useky obsahujf
poznamky, upozornéni a vystrahy. Jejich pouzitf
je nasledujict:

€& Poznimka

Tento symbol oznacuje dllezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniuji, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobg a nemusi byt uvozeny symbolem.V
takovém pripade je konkrétni vyznaceni vystrahy
naf{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.



http://www.philips.com/about/sustainability/recycling
http://www.philips.com/about/sustainability/recycling

1.4 Ddlezité informace o bezpecnosti
pred sledovanim 3D obrazu

Optimalni 3D zobrazeni

V zdjmu optimalniho 3D zobrazeni
doporucujeme, abyste:

»  Sedéli ve vzddlenosti nejméné 55 cm.

*  Sledovali monitor mimo primé slunecnf
zdreni, které by mohlo narusit 3D vjem.

Zdravotni upozornéni souvisejici s 3D

*  Pokud se ve vasi rodiné vyskytuje epilepsie
nebo zdchvaty souvisejicl se svétlem,
obrat'te se na Iékare, difve nez se vystavite
pUsobenf blikajicich svételnych zdrojd,
rychlych sekvenci obrazd nebo 3D obrazu.

*  Abyste zabranili nepohodli, napiiklad
z4vrati, bolesti hlavy nebo ztrdté orientace,
doporucujeme nesledovat 3D obraz delsi
dobu. Pokud citite nepohodli, prestarite
sledovat 3D obraz a nezacinejte s
potencidlné nebezpecnymi cinnostmi (napr.
fizeni auta), dokud symptomy nepominou.
Pokud symptomy pretrvavaji, nedivejte se
znovu na 3D obsah, aniz byste se poradili
s |ékarem.

* Rodice by meli sledovat d&ti, které sledujf
3D obraz, a ujistit se, ze netrpi vyse
zminénym nepohodlim. Sledovani 3D se
nedoporucuje détem do Sesti let veku,
jejichZ zrakové orgdny jesté nejsou plné
vyvinuty.

*  Nepouzivejte 3D bryle k jinému Ucelu nez
ke sledovani 3D obrazu.

Péce o bryle

» 3D bryle nevystavujte primému slunecnimu
zérenf, horku, ohni a vodé. Hrozf porucha
produktu nebo pozar.

* Ocnice 3D bryli chrarite pred pady, ohyby
a silou.

e K isténl ocnic pouzijte Cisty mékky hadr
(mikrovldkno nebo bavinény flanel), aby
se neposkrdbaly. Nikdy nestrikejte Cisticl
prostredek prfimo na 3D bryle.

*  Nepouzivejte isticl chemikdlie s obsahem
alkoholu, rozpoustédla, povrchové aktivnf
latky, vosku, benzinu, rfedidla, repelentu nebo
maziva. PouZzitf téchto chemikdlii mize
zpUsobit zménu barvy nebo praskliny.



’ . Namontujte stojanek podstavce
2. Nastaveni monitoru Bl Namontujte stojénel podstav

1. Umistéte monitor obrazovkou dold na
meékky a hladky podklad, aby nedoslo k
poskrabdni obrazovky.

2.1 Instalace

El Obsah krabice

QSU:Eart

2. Uchopte monitor obéma rukama a
 ———rrr e pripevnéte stojanek podstavce do sloupku

\M/ podstavce.

N
4 €
v ] @ s
VGA (nepovinny) HDMI (volitelné)

'

&)

Y Y
Zvukovy kabel Nacvakavaci 3D bryle 3D bryle
(volitelny)



El Pripojeni k poéitaci

PHILIPS

‘
b
:

@ Vstup stiidavého napdjent

© VstupVGA

© Vstupy HDMI (HDMI1 a HDMIR)

O Vystup zvuku HDMI

O Z3amek proti krddezi Kensington

O 3D bryle

Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjecl
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.

5. Zapnéte pocita¢ a monitor: Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.

6. Nasadte si “Nacvakdvaci 3D bryle” nebo
“3D bryle” a stisknéte kldvesu 3D na
prednim rdmecku. Jste pfipraveni sledovat
3D obrazy.

& Poznimka

3D bryle jsou navrzeny pouze pro sledovani
3D obrazu. Je velmi dilezité pouzivat 3D bryle
prilozené k monitoru.

Pokud pri sledovéni 3D obrazu sedite mimo
specifikovany Uhel nebo vzdélenost, hrozf
prekryvani nebo nespravné zobrazeni 3D
obrazu.



2.2 Ovladani monitoru

El Popis vyrobku z Eelniho pohledu

/4 ©/v 3D/A B/oK 0]

L
9066 0 © o

Slouzi k ZAPNUTI a VYPNUT(

|

o o napajeni monitoru.

Slouzi ke vstupu do nabidky
0 &/0KOsh.

Potvrzen( nastaveni OSD
© | A V¥ [SlouZi k dpravdm nabidky OSD.
O | 3D |Rychlé tlacitko 3D.

Slouzi ke zméné zdroje
6 © vstupniho signdlu.
0 < Slouzi k ndvratu na predchozf

droveri OSD.

Rychlé tlacitko Smartlmage

Lze vybrat néktery ze Sesti

Q@ @ rezima: Office (Kancelar), Photo
(Fotografie), Movie (Film), Game

(Hra), Economy (Usporny), Off

(Vypnuto).

Rychlé tlacitko 3D:

2D-3D
L-R(side by side)
R-L(side by side)

Top-Bottom

Bottom-Top

off

1. 2D-3D: Pokud je zapnuta funkce “2D-3D",
mUzete sledovat 3D obraz z 2D zdroje
signdlu.

2. 3D (AUTO) : uzivatel si mize vybrat z
téchto dvou pouzitf:

*  Game console / Blu-ray player / Graphic

card (Herni konzole/prehravac Blu-ray/
grafickd karta): podpora HDMI 1.4a 3D

*  PC Game (PC hra): s pouzitim TriDef 3D

& Poznimka

CELA OBRAZOVKA je zékladni nastaven pfi
sledovani 3D obrazu. KE SLEDOVANI AUTO
3D OBRAZU JE NUTNE HDMI 1.4a. 3D Ize
také aktivovat rucni volbou klavesami 3D z OSD
menu, jak je uvedeno nize:



Na vybér jsou ndsledujici formaty videa: Po zapnuti 3D obrazu se v pravém hornim rohu
b ky na 5 sekund zobrazi logo 3D.
3. L-R(side by side) (L-P (vedle sebe)): obrazoviey na > sekund zobraz! logo

VGA (D-sub) pro 3D aplikaci:vyberte v
nabidce OSD volbu Setup (Nastaven()=»Auto
(Automatické nastaven), abyste zajistili spravnou
funkénost 3D zobrazeni. Pokud nezvolite
moznost "Auto", obraz bude roztreseny.

€& Poznimka
Znacka 3D nebude zobrazovéna, pokud se
vyuzivd 3D funkce ke hraniTriDef her,

E1 Popis zobrazeni funkci na obrazovce

5. Top-Bottom (Horni-Dolni): Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

Horni obraz LCD Philips. Umozfiuje koncovému uZivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru primo prostrednictvim
zobrazeného okna s pokyny. Nize je uveden
priklad prijlemného rozhrani obrazovky:

Dolni obraz

ENAT)
6. Bottom-Top (Dolni-Horni):

Dolni obraz

Horni obraz

Zakladni a jednoduché pokyny k ovladacim
tlacitkiim

7. Off (Vypnuto): 3D funkce je vypnutd.
(Vypruto) jevrp Ve vyse uvedené nabidce obrazovky OSD

muzete stisknutim tlacitek ¥ A na prednim
rédmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.



Nabidka OSD

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mazete vyuzit, budete-li
chtit pozd&ji prozkoumat rdiznd nastaven.

Main menu Sub menu
— 3D r— 2D-3D Depth
]: Separation
— 3D(Auto)
F— L-R(Side by side)
— R-L(Side by side)
— Top-Bottom
— Bottom-Top
— Off
— Input — VGA
— HDMI1
— HDMI2
— Picture r— Picture Format — Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartResponse —— Off, Fast, Faster, Fastest
— SmartContrast — On, Off
— Gamma — 18,20,22,24,2
— Over Sacn — On, Off
— Audio r— Volume — 0~100
— Stand-Alone — On, Off
— Mute — On, Off
— Color [ Color Temperatre  — 5000K, 6500K, 7500K,
8200K, 9300K, 11500K
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Francais, Deutsch, ltaliano,
Portugués, Pycckmit, I {&F 3
— OSD Settings [ Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
—— OSD Time Out — 55, 108, 20S, 305, 60S
L— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L— Information

El Poznamka k rozliseni

Tento monitor je uréen pro optimalnf vykon
pri nativnim rozliseni 1920 x 1080 @ 60 Hz.
KdyZ je monitor zapnut pfi jiném rozlidenf, na
obrazovce se zobrazi vystraha: Use 1920 x
1080 @ 60 Hz for best results (Pro optimalnf
vysledek pouzijte rozliseni 1920 x 1080 pri 60
Hz).

Zobrazovani vystrahy na nativni rozlisenf Ize
vypnout v ¢dsti Nastaveni v nabidce OSD.

B Fyzické funkce
Naklon




2.3 Odpoijte stojanek podstavce a 1 DemontiZ podstavce

podstavec 1. Mazete zasunout plochy Sroubovdk do
dvou uvolfiovaci otvord na krytu zdvésu a
El Demonté? stojanku podstavce jemnym pacenim jej odstrarite.

Nez zatnete demontovat podstavec monitoru,
postupuijte podle pokynd nize, aby se zabrdnilo
jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou dold na
meékky podklad, aby nedoslo k poskrabdnf
obrazovky.

2. Odmontujte 4 Srouby a potom sejméte
podstavec z monitoru.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojeni sloupku podstavce stisknéte
uvolfiovacf tlacitko.

© Poznamka

Tento monitor je kompatibilni's 1700 mm x 100
mm montdznim rozhranim kompatibilnim se
standardem VESA.

PHILIPS
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3. Optimalizace Obrazu

3.1 Smartlmage

E Cojeto?

Funkce Smartlmage nabizi scéndre, které
optimalizujf zobrazenf riznych typt obsahu a
dynamicky zlep3uje jas, kontrast, barvy a ostrost
v redlném case. Funkce Philips Smartlmage
prindsi optimalizované zobrazeni monitoru

bez ohledu na to, zda pracujete s aplikacemi,
prohlizite obrdzky nebo sledujete video.

Bl Prog to potiebuii?

ProtoZe chcete sledovat monitor, ktery

prindsi optimalizované zobrazen( viech vasich
oblibenych typd obsahu. Software Smartimage
dynamicky upravuje jas, kontrast, barvy a ostrost
v redlném case pro dosazen( nejlepsiho zdzitku
ze sledovani monitoru.

E Jak to funguje?

Smartlmage exkluzivni $pickova technologie
spole¢nosti Philips, kterd analyzuje obsah
zobrazeny na obrazovce. Na zdkladé vami
zvoleného scénare technologie Smartlmage
dynamicky zlep3uje kontrast, sytost barev a
ostrost obrazu pro vylepseni zobrazovaného
obsahu — vSe v redlném case stisknutim jediného
tlacitka.

B Jak aktivovat Smartimage?

1. Stisknutim @D spustite Smartimage na
obrazovce.

2. Opakovanym stiskem e» prepinejte Office
(Kancelar), Photo (Foto), Movie (Film),
Game (Hra), Economy (Uspora) nebo Off
(Vypnuto).

11

3. Zobrazeni Smartlmage zlstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka ,,OK".

4. Po aktivaci technologie Smartlmage je
automaticky deaktivovdno schéma sRGB.
Aby bylo mozné pouzit schéma sRGB,
je tfeba deaktivovat funkci Smartlmage
stisknutim tlacitka B na prednim panelu
monitoru.

Kromé tla¢ftka @) pro prochdzeni dold miizete
rovné€z provést vybér stisknutim tlacftek w A,
potvrdit vybér stisknutim tlacftka ,,OK" a ukondit
nabidku Smartimage OSD.

Lze vybrat néktery ze Sesti rezimd: Office
(Kancelar), Photo (Foto), Movie (Film), Game
(Hra), Economy (Uspora) a Off (Vypnuto).

@ SmartImage
Office
Photo
Movie

Game

Economy

Ooff

» Office (Kancelar): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezenf
namahdni zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri praci
s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

*  Photo (Fotografie): Tento profil kombinuje
vylepsenf sytosti barev, dynamického
kontrastu a ostrosti pro zobrazenf fotografif
a daldich obrdzkd s vynikajici Cistotou v
Zivych barvdch — to vie bez artefaktl a
vybledlych barev.

*  Movie (Film): Zvysena svitivost,
prohloubend sytost barev, dynamicky
kontrast a Ziletkovd ostrost zobrazujf
kazdy detail v tmavsich ¢dstech videa bez
deformace barev v jasnéjsich ¢astech a
udrzuji dynamické prirozené hodnoty pro
dokonalé zobrazenf videa.

*  Game (Hra): Tento profil prindsi nejlepsf
hernf zaZitek pro hrdce, protoze aktivuje
prebuzeny okruh pro optimdini dobu



odezvy, omezeni zubatych okraji rychle

se pohybujicich objektl na obrazovce a
vylepseni kontrastntho poméru pro jasné a
tmavé scény.

+  Economy (Usporny): V tomto profilu jsou
upraveny jas a kontrast a jemné vyladé&no
podsvicen( pro zajisténi optimdiniho
zobrazenf béZnych kanceldrskych aplikaci a
niz8( spotfebu energie.

» Off (Vypnuto): Nenf pouzita optimalizace
funkce Smartlmage.

3.2 SmartContrast

E Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastnf pomér monitoru pro maximdalnf
vizudlni distotu a pozitek ze sledovdni. Zvysuje
podsviceni pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsvicen( pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Prog to potiebuii?

Zadéte nejvy¥f vizudlni gistotu a pohodl
sledovant jakéhokoli typu obsahu. SmartContrast
dynamicky ridi kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazenf her a videa
nebo pro zobrazeni jasného, ¢itelného textu

pro kancelarskou prédci. Omezenim spotreby
monitoru Setffte naklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicenf. Tato
funkce bude dynamicky vylepsovat kontrast pro
skvély zazitek pri prohlizenf fotografii nebo hranf
her.
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3.3 Philips SmartControl Premium

Novy software SmartControl Premium od
spole¢nosti Philips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. SloZitd nastaven( jsou
minulostf, protoZe tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlisent, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilnf se systémem
Windows 7, ktery je vybaven nejnovéjs
technologi v jddrovém algoritmu pro rychlé
zpracovani a odezvu, je pripraven rozsifit vasi
zkusenost s monitory Philips!

El Instalace
» Postupujte podle pokynli a dokoncete
instalaci.

*  Mulzete spustit po dokoncenf instalace.

»  Chcete-li spustit pozdégji, mizete klepnout
na zéstupce na pracovni plose nebo na
panel ndstroju.

Prvni spusténi — Privodce

e Priprvnim spusténi po instalaci prejde
SmartControl Premium automaticky na
Privodce.

* Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.



Privodce mUzete rovnéz spustit pozdéji z
nabidky Plug-in (Zdsuvny modul).

Dalsi moZnosti mudzete nastavit bez
privodce prostrednictvim podokna
Standard (Standardnf).

E1 Spusténi s podoknem Standard

(Standardni)

Nabidka Adjust (Nastaveni)

Nabidka Adjust (Nastaven() umozniuje
upravit Brightness (Jas), Contrast
(Kontrast), Focus (Ohnisko), Position
(Poloha) a Resolution (Rozlisen).
Muzete postupovat podle pokynt a
provést nastavent.

Cancel (Storno) vyziva uzivatele, chcete-li
ukondit instalaci.
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Nabidka Color (Barva)

*  Nabidka Color (Barva) umozfiuje upravit
RGB, Black Level (Urover cerné), White
Point (Bily bod), Color Calibration
(Kalibrace barev) a Smartimage (viz ¢ést
Smartlmage).

*  MdZete postupovat podle pokynU a
provést nastavent.

* V ndsledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.

» Priklad pro Color Calibration (Kalibrace
barev).

1. Tlacitko ,,Show Me'" (Predvést) spustf
vyukovy program pro kalibraci barev.
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2. Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

3. Quick View (Rychlé zobrazen) nacte
zobrazeni pred/po.

4. Chcete-li se vrétit na hlavni strdnku Color
(Barva), klepnéte na tlacftko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychoz konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta,
kalibraci barev nelze provést a tlacitka Start
a rychlé zobrazeni nejsou k dispozici.

6. Na kalibracni obrazovce musi byt
zobrazeny informace o patentech.

Obrazovka kalibrace prvni barva

» Tlacitko Previous (Predchoz) je
deaktivovano az na obrazovku druhé
barvy.

* Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujicl cil (6 cild).

* Nakonec prejdéte na podokno File >
Presets (Soubor > Predvolby).

*  Tlac¢itko Cancel (Storno) slouzi k ukonéenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych modull plug-in.
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Smartlmage

Smartlmage — umoziiuje uzivateli zménit
nastaven( pro vylepSenf zobrazenf na zdkladé
obsahu.

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.

Nabidka ECO



Nabidka Options (Moznosti)

Podokno Theft Deterrence (Zabezpecen proti
krddezi) bude aktivni pouze po vybéru polozky
rezim Theft Deterrence (Zabezpecen proti
krddezi) z rozeviracl nabidky Plug-in (Zdsuvny
modul).

Chcete-li aktivovat Theft Deterence
(Zabezpeceni proti krddezi), kliknéte na tlacitko
Enable Theft Deterrence Mode (Aktivovat
rezim zabezpecen( proti krddezi) a zobrazi se
nasleduijici okno:

*  UZivatel miZe zadat kéd PIN, ktery
obsahuje pouze 4 az 9 &islic.

*  Po zaddni kédu PIN a kliknuti na tlacitko
Accept (Prijmout) se zobrazi mistnf
dialogové okno na ndsledujici strance.

e Minimdlni pocet minut nastaven na 5.
Posuvnik nastaven ve vychozi konfiguraci
na 5.

* Aby bylo mozné prejit do rezimu Theft
Deterence (Zabezpecenf proti kradezi),
zobrazovaci zafizenf nemusf byt pripojeno
k odlisnému hostiteli.

Po vytvoren( kddu PIN bude na podokné

Theft Deterence (Zabezpecen proti krddeZzi)

zobrazena informace Theft Deterence Enabled

(Zabezpecleni proti krddezi aktivovdno) a bude

k dispozici tlacitko PIN Options (Moznosti kédu

PIN):

* Je zobrazena informace Theft Deterrence
Enabled (Zabezpecen proti kradezi
aktivovano).

*  Kliknutim na tlacitko deaktivovat Theft
Deterence (Zabezpelen proti krddezi) se
otevr'e podokno na ndsledujici strané.

*  Tlacitko PIN Options (Moznosti kédu PIN)
je k dispozici pouze po vytvoreni kédu PIN
a slouzf k otevrenf serveru zabezpeceného
kédem PIN.

Options>Preferences (Moznosti>Predvolby)
—Tato moznost bude aktivni pouze po

vybéru polozky Preferences (Predvolby) v
rozeviraci nabidce Options (Moznosti). Na
nepodporovaném zobrazovacim zarizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

» Zobrazi nastaven( aktudlnich predvoleb.

e Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtédvaci policko je prepinac.

» Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychoz( konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context Menu
(Povolit mistni nabidku) se na pracovni
plose zobrazi vybéry SmartControl
Premium pro funkce Select Preset
(Vybrat predvolbu) a Tune Display
(Ladéni zobrazen), pokud klepnutim
pravym tlacitkem mysi zobrazite mistn{
nabidku. Volbou moZnosti Deaktivovdno
bude polozka SmartControl Premium
odstranéna z mistni nabidky pravym
tlacitkem mysi.



Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Enable Context Menu (Povolit mistnf
nabfdku) se zobrazf nabidka SmartControl
Premium na hlavnim panelu. Klepnutim
pravym tlacitkem mysi na ikonu na hlavnim
panelu se zobrazi moznosti nabidky Help
(Ndpovéda), Technical Support (Odbornd
pomoc), Check for Update (Vyhledat
aktualizace), About (O aplikaci) a Exit
(Konec). Kdyz je deaktivovdna polozka
Enable Task Tray menu (Povolit nabidku na
hlavnim panelu), ikona na hlavnim panelu
zobrazuje pouze moznost EXIT (KONEC).

Polozka Run at Startup (Spustit pri startu)
je ve vychozi konfiguraci zaskrtnutd
(Zapnuto). Kdyz je tato polozka
deaktivovana, funkce SmartControl
Premium se nespusti pfi startu nebo
nebude na hlavnim panelu. Funkci
SmartControl Premium Ize spustit
pouze prostrednictvim zdstupce na
pracovni plose nebo prostrednictvim
souboru programu. KdyZz toto poli¢ko
nenf zaskrtnuté (Deaktivovano), zadna
predvolba nastavend pro spusténf pri
startu nebude nactena.

Aktivovat rezim prahlednosti (Windows
7, Vista, XP). Vychozi nastavenf je O %
neprihlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Napovéda)

a Options (Moznosti). Zadné dal3f karty funkce
SmartControl Premium nejsou k dispozici.
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» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudlniho zdroje vstupu.

* U zobrazovacich zaffzenf s jednim vstupem
neni toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Zvuk) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).



Option>Auto Pivot (Moznost>Auto otaceni)

Nabidka Help (Napovéda)

Help>User Manual (Napovéda>Uzivatelska
pfirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd

prirucka) v rozeviraci nabidce Help (Ndpovéda).

Na nepodporovaném zobrazovacim zafizen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru

polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).
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Context Sensitive menu (Mistni nabidka)
Context Sensitive menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti
Options (Moznosti)>podokno Preferences
(Predvolby).

@ SmartControl Premivm
Select Presst 4
Tune Display

rwer Saver 4

Office
Photo
Movis
Text
Game

Economyr

Context Menu (Mistni nabidka) obsahuje Ctyri

polozky:

*  SmartControl Premium - po vybéru se
zobrazf obrazovka About (O aplikaci).

* Select Preset (Vybrat predvolbu) —
nabizf hierarchickou nabidku ulozenych
predvoleb pro okamzité pouziti.

Aktudlné vybrand predvolba je oznacena
zaskrtnutim. V rozeviraci nabidce Ize
rovné€z vybrat polozku Factory Preset
(Predvolby vyrobce).

* Tune Display (Ladéni zobrazeni) — otevr'e
ovlddaci panel SmartControl Premium.

* Smartlmage - Zkontrolujte aktudlnf
nastaveni: Off (Vypnuto), Office



(Kanceldr), Photo (Foto), Movie (Film),
Game (Hra), Economy (Uspora).

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Premium na hlavnim panelu. Klepnutim levym
tlacitkem Ize spustit aplikaci.

Hlavnf panel obsahuje pét polozek:

* Help (Napovéda) — pristup k souboru s
User Manual (Uzivatelskou priruckou):
Otevr'e soubor s User Manual
(Uzivatelskou priruckou) v okné vychoziho
prohlizece.

* Technical Support (Odborna pomoc) —
zobrazf stranku odborné pomoci.

* Check for Update (Vyhledat aktualizace)
— zobrazfl Gvodni stranku PDI a porovnd
uzivatelovu verzi s nejaktudlnéjsi
dostupnou verzi.

* About (O aplikaci) — zobrazf podrobné
referencnf informace: verze produktu,
informace o vydanf a ndzev produktu.

» Exit (Konec) - ukon¢i SmartControl
Premium.

Chcete-li znovu spustit funkci SmartControl
Premium, vyberte polozku SmartControl
Premium z nabidky Program, poklepejte

na ikonu na pracovni plose pocitace nebo
restartujte pocitac.
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Deaktivovana nabidka hlavniho panelu

Kdyz je Hlavni panel deaktivovén ve slozce
Preference (Predvolby), je k dispozici pouze
cast Exit (Konec). Cheete-li funkci SmartControl
Premium zcela odstranit z hlavniho panelu,
deaktivujte polozku Run at Startup (Spustit

pri startu) v ¢asti Options>Preferences
(Moznosti>Predvolby).

& Poznimka

Vsechny obrdzky v této sekci jsou pouze
orientacni.Verze softwaru SmartControl se
muze bez upozornéni ménit.Vzdy na oficidinim
webu Portrait www.portrait.com/dtune/phl/
enu/index vyhledejte nejnovejsi verzi softwaru
SmartControl.



www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

4. Sledovani 3D s pouzitim

softwaru TriDef 3D

4.1 Pozadavky na pocitac

Doporucené pozadavky na pocitac:

Procesor Intel® Core i5 nebo AMD
Phenom™ Il X4 CPU nebo lepsi

2GB RAM

NVIDIA® GeForce® GTS 450 nebo AMD
Radeon™ HD5750 nebo lepsi

500 MB volného mista na disku

Windows® XP (SP3) (pouze 32bitovd
verze), Windows® Vista (pouze 32bitovd
verze) nebo Windows® 7 (32 nebo
64bitovd verze)

Zvukova karta kompatibilnf s DirectX 9.0c
Pripojen( k Internetu

Jednotka DVD-ROM

Sitovd karta

DirectX 9.0c

Minimalni pozadavky na pocitac

Procesor Intel® Core 2 Duo nebo AMD
Athlon™ 64 X2 Dual-Core nebo lepsi

1GB RAM

NVIDIA® GeForce® 8600 GT nebo ATI
X1650 XT

500 MB volného mista na disku

Windows® XP (SP3) (pouze 32bitova
verze), Windows® Vista (pouze 32bitovd
verze) nebo Windows® 7 (32 nebo
64bitovd verze)

Zvukova karta kompatibilni s DirectX 9.0c
Pripojeni k Internetu

Jednotka DVD-ROM

Sitovd karta

DirectX 9.0c
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4.2 Instalacni prirucka k softwaru
TriDef 3D

Vlozte CD nazvané “Monitor user’s manual”
(UZivatelskd prirucka monitoru). Spustte
spustitelny soubor (TriDef-3D XXX.exe).

1. Kliknéte na tlacitko "Next" (Dalsi).

2. Kliknéte na tlacitko "Install" (Instalovat).

3. Kliknéte na tlacitko "Finish" (Dokoncit).
Instalace ovladace TriDef je hotova.



ikona aplikace. Zobrazit seznam
+ Shift +
(ol == B F kldvesovych zkratek

Alt + Shift + - [Zapnout/vypnout 3D
Alt + Shift + [ | SniZit hloubku zobrazeni
Alt + Shift + ] [Zvysit hloubku zobrazenf

Alt + Shift + , [SniZit procento vepredu
Alt + Shift + . [ZvyZit procento vpredu
5. Pokud zvolite moznost "Play 3D Games" Alt + Shift + = |Rychlost ostFenf
(Hrdt 3D hry), mazete kliknutim na tlacitko Vo Dout/ Za0nout [aserovy
"Scan" (Prohledat) zobrazit viechny 3D hry Ale+ Shife + \ | VEROTHER K

nainstalované v pocitaci.
PrtSen (SysReq) 3D snimek obrazovky
Kliknutim na tla¢ftko "Launch" (Spustit) Alt + Shift +
mUzete zacit hrat hry, nasadte si 3D bryle a Alt + Shift +
pustte se do hranf.

Roztdhnout obraz

;| Zuzit obraz

Zvysit preskenovani

Alt + Shift + L
) obrazu
Seznam podporovanych 3D her najdete na R R e ————
adrese http/Mmwwitridef.com/ignition/3d- £ nizit preskenovani obrazu
games.html. Al + Shift =V Zapnout/vypnout virtualni
3D

Alt + Shift + R [Obnovit vychozi nastavenf

€& Pozniamka
Vsechny snimky obrazovek zobrazené vyse jsou
pouze orientacnf.

6. Nize najdete preehled kldvesovych zkratek
pro "Play 3D Games" (Hrdt 3D her). Dalsi
informace ziskdte v "TriDef User Guide"
(Uzivatelské prirucce k softwaru TriDef).
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5. Technickeé udaje

Typ zobrazovaciho panelu TFI-LCD

Podsvicenf LED

Velikost panelu 23" S (58,4cm)

Pomér stran 16:9

Rozte¢ obrazovych bodl 0,265 (v) mm x 0,265 (s) mm
Jas 250 cd/m?

SmartContrast 20,000,000:1

Kontrastni pomér (typ.) 1000:1

Doba odezvy (typ.) 5ms

Cas SmartResponse (typ.) 2 ms

Optimalnf rozlisenf

1920 x 1080 @ 60 Hz

Zorny Uhel

170° (H) / 160° (V) pti C/R > 10

3D zobrazovaci dhel

80° (H) / 12° (V) p#i 3D CT < 10

Barevnost displeje

16,7 milionu barev

Vstup signdlu

Vertikdlni obnovovaci frekvence 50Hz — 75Hz
HorizontéIni frekvence 30kHz — 83kHz
sRGB ANO

HDMI1, HDMI2 (digitdlni), VGA (analogovy)

Vstupnf signdl

Usnadnéni pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

/4 /v 3D/A BS/oK 0]

Jazyky nabidky OSD

anglictina, francouzstina, némcina, Spanélstina, italstina, rustina,
zjednodudena ¢instina, portugalstina

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif Plug
& Play

DDC/Cl, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Néklon

-5/+20

Rezim Zapnuto

28,39 W (typ.), 31,3 W (max.)

Spének (pohotovost)

05W

Vypnuto

03W

Indikdtor LED napdjenf

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blika)

Napdjenf

Integrovany, 100 — 240 VAC, 50 — 60Hz

Vyrobek s podstavce (SxVxH)

566 x 426 x 219 mm

Vyrobek bez podstavce (5xVxH)

566 x 355 x 54 mm
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Vyrobek s podstavcem 3,26kg
Vyrobek bez podstavce 3,03kg
Vyrobek s obalem 4,65kg
Teplotni rozsah (provoz) 0°Caz 40 °C
Ro;sah teplot 20°C 2% 60°C
(mimo provoz:)

Relativni vihkost 20% az 80%

Pouzivani: + 12 000 stop (3 658 m)

Nadmorsid vyska Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.
[Ekologe ]
ROHS ANO
EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny
Specifické latky Kryt 1009 bez PVC BFR
Energy Star ANO

Prohldseni o shodé Znacka CE, FCC tr{da B, SEMKO, UL/cUL, BSMI, GOST, GS

Barva

Cernd

Povrchovd Uprava

Textura

© Poznimka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

2. Tyto Udaje se mohou zménit bez predchoziho ozndmenf. Stdhnéte si nejnovejsi verzi letdku z webu

www.philips.com/support.
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5.1 Rezimy rozliseni a predvoleb

El Maximalni rozliseni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitalni vstup)

E1 Doporuéené rozliseni
1920 x 1080 pi 60 Hz (digitdini vstup)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

El Doporucené rozliseni pro 3D
1920 x 1080 pri 60 Hz (digitdni vstup)
Podporované frekvence pro 3D:

27 1920 x 1080p 24%
56,25 1920 x 1080p 50
67,5 1920 x 1080p 60
37,5 1280 x 720 50
45 1280 x 720 60
* pouze HDMI
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& Poznimka

Upozorfiujeme vds, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozlisent.



6. Rizeni spotieby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotiebu energie, neni-li pouzivan.
Pokud pocitac rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky "probudi™. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro
automatickou Usporu energie:

Spotieba Barva

ReZzim VESA | Video | H-synch.| V-synch. pOLet indikatoru
energie LED
- 28,39 W (typ.) .
Aktivnf ZAPR Ano Ano 313W (max) Bild

Spének % (4
(EelieiaEs) VYR Ne Ne 05W (typ) [Bila (blikd)

Vypnuto VYP - - 03 W (typ.) VYR

Ndsledujic konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

* Nativnf rozliseni: 1920 x 1080

*  Kontrast: 50%

*  Jas: 250 nitd

* Barevnd teplota: 6500 K s pIné bilym

vzorkem

© Poznamka
Tyto ddaje se mohou zménit bez predchoziho
ozndment.
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7. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

X, The EPEAT (Electronic
QQ' Product Environmental
& Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

» EN60950-1:2006+A11:2009 (Safety
requirement of Information Technology
Equipment).

»  EN55022:2006+A1:2007 (Radio
Disturbance requirement of Information
Technology Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

«  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

4)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.


http://www.energystar.gov

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

28

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RRZHENERIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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8. Péce o zakazniky a zaruka

8.1 Postup pri vadnych pixelech
plochého panelu spoleénosti Philips

Spolecnost Philips se snazi doddvat produkty
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodd u panelti monitord TFT, které se pouZzivajf
pro ploché monitory, se nicméné nékdy nedd
zabranit. Zadny vyrobce nemuize zarudit, ze
vsechny panely budou bez defektd obrazovych
bodd, ale spole¢nost Philips zarucuje, ze kazdy
monitor s nepfijatelnym poctem defektd bude v
rdmci zdruky opraven nebo vyménén.Tento text
vysvétluje jednotlivé druhy defektl na pixelech
a urcuje Unosnou Uroven chybovosti pro kazdy
druh. Aby bylo mozné uplatnit zdrucni opravu
nebo vymeénu, musi pocet defektnich obrazovych
bodd panelu monitoru TFT presdhnout tuto
droveri Unosnosti. Na monitoru napfiklad nesmf
byt vice defektnich dil¢ich obrazovych bodt nez
0,0004 %. Déle, protoze nékteré typy kombinacf
vad pixell jsou lépe postrehnutelné neZ jiné,
stanovuje pro né spolecnost Philips jesté vetsi
ndroky na kvalitu. Tato norma se dodrzuje
celosv&tove.

subpixely

R G B
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze tif
subpixeld v zdkladnich barvdch cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadg, tvorf
obraz. Kdyz viechny subpixely urcitého pixelu
svitf, jevi se tyto tii subpixely spolecné jako
jediny bily pixel. Kdyz jsou vechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.

Druhy pixelovych vad

Vady pixel(l a subpixeld se na obrazovce
projevujf riznymi zpUsoby. Existuji dva druhy vad
pixelu a v rdmci téchto druhd je nékolik typd
subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou ,,aktivni*. Svétly bod je dilct
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavd plocha. Existujf
nasledujici typy defektl svétlych bodu.

Jeden cerveny, zeleny nebo modry subpixel.

1 ¢

Dva soundleZicf subpixely:

- cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



€& Poznimka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedni body.

Defekty tmavych bodl

Defekty tmavych bodu se projevuif jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesvitl nebo jsou ,neaktivni'. Tmavy bod je
dilei obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena svétld plocha.
Existuji nasledujici typy defektd tmavych bodd.

KAZY JASNYCH BODU

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzddlenost vad pixeld.

Tolerance vad pixeld

Aby bylo mozné uplatnit opravu nebo vyménu
kvadli defektnim obrazovym bodlm v zaru¢nf
dobé, musi panel TFT v plochém monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bodu, které prekracujf
tolerance uvedené v nasledujicich tabulkéch.

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedn/ trvale svitici body 1
3 sousedni trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodu viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cernych bodi*

>15 mm

Celkovy pocet kazli cernych bodu viech typl

5 nebo méné

KAZY BODU CELKEM

Celkovy pocet kazll jasnych nebo cernych bodut viech typl

PRIJATELNY POCET VAD
5 nebo méné

© Poznimka

1. 1 nebo 2 sousednf vadné body (1 barva) = 1 vadny bod

2. Tento monitor je kompatibilni se standardem 1SO9241-307 (1ISO9241-307: Ergonomicky pozadavek,
analyza a metody testovani shody pro elektronickd zobrazovaci zarizenf)
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8.2 Péce o zakazniky & zaruka

Podrobné informace o zéruce a pozadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens 1&S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI AVYCHODNI EVROPY:

Telefonni stredisko

Cislo zakaznické péce

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
?’Iec::itaer%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ut NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 73 31
R NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Brazil

Argentina

Telefonni stredisko

Vermont

Cislo zakaznické péce
0800-7254101

0800 3330 856

Kontaktni informace pro Cinu:

Cina

Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Zemé Telefonni stredisko  ASC Cislo zakaznické péce
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | 1. i Tel: (853)-0800-987
. Tel:1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Prima UEBCA 2 B, I
7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
onited Arab 0 AL SHAHD COMPUTER LL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
EPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Cormpany Lid +84 5113.562666 Danang City
Py +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 1o 60
Sri Lanka NA no d}s‘trlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
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9. Odstranovani probléma a
Casté dotazy

9.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mlze odstranit uzivatel. Pokud problém
pretrvavd i po vyzkouseni téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy
Zadny obraz (indikator LED napajeni nesviti)
»  Zkontrolujte, zda je napdjeci kabel pripojen

k elektrické zdsuvce a do zadnf asti
monitoru.

*  Nejdrfve zkontrolujte, zda se vypinac
na prednf stran& monitoru nachdzi ve
VYPNUTE poloze a stisknéte jej do
ZAPNUTE polohy.

Zadny obraz (indikator LED napijeni je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitaci.

»  Zkontrolujte, zda nejsou ohnuté koliky na

pripojovaci stran& kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

* Pravdépodobné je aktivovana funkce rizenf
spotreby

Obrazovka Fika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rdadné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

*  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocitac.

Tlaéitko Auto (Automaticka) nefunguje.

* Automatickd funkce je pouzitelnd pouze
v rezimu VGA-Analog (VGA-analogovy).
Pokud vysledek nenf uspokojivy, mizete
provést rucni Upravy prostrednictvim
nabidky OSD.

€& Pozniamka

Auto (Automatickd) funkce nenf pouzitelnd v
rezimu DVI-Digital (DVI-digitdlni), protoze je
zbytednd.

Viditelné znamky koure nebo jiskFeni

*  Neprovddéjte zddné kroky pro
odstraffovani probléma

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

Bl Problémy se zobrazenim

Obraz neni vystredén

* Upravte polohu obrazu pomocf funkce
JAuto' (Automatickd) v hlavnich ovlddacich
prvcich OSD.

*  Upravte polohu obrazu pomocf polozek
Phase/Clock (Féze/frekvence) v asti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo
k pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
LAuto” (Automatickd) v hlavnich ovlddacich
prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.



Dochazi k vodorovnému blikani

* Upravte polohu obrazu pomoci funkce
JAuto' (Automatickd) v hlavnich ovlddacich
prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v Hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo pfilis
tmavy

* Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napéjeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypéleni* obrazovky, rovnéz
znamé jako ,,dosvit"* nebo , zobrazenf
duchd"., Vypdleni*, ,,dosvit" nebo
,,zobrazenf duchl" je dobre zndmy jev
u technologie paneld LCD.V mnoha
pripadech "vypalent", "dosvit" nebo
"zobrazeni duchl" postupné zmizi po urcité
dobé mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Pokud neaktivujete spori¢ obrazovky nebo
aplikaci, kterd pravidelné obméniuje obsah
zobrazenf, mize dojit k vdznému ,,vypdleni*,
,,dosvitu"* nebo ,,zobrazenf duch(”, a toto
naruseni obrazu jiz nelze odstranit. Na vyse

uvedené poskozen se nevztahuje zdruka.

Obraz je zdeformovany.Text je nejasny nebo
rozmazany.

» Nastavte rozliseni zobrazeni pocitace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozliseni obrazovky
monitoru.
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Na obrazovce se objevuji zelené, éerveng,
modré, tmavé a bilé tecky

»  Zbyvajici body jsou normdlnf vlastnostf
tekutych krystald pouzivanych souc¢asnou
technologii. Dalsi podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

*  MulZete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Indikdtor LED napdjenf
v ¢dsti Nastaven( v Hlavnf oviddaci prvky
nabidky OSD.

Potrebujete-li dalsi pomoc, viz seznam
Informadnf strediska pro zékazniky a kontaktujte
zdstupce sluzeb pro zdkaznfky spolecnosti
Philips.

9.2 SmartControl Premium - ¢asté
dotazy

Ot.1: Zmeénil jsem monitor v pocitaci za jiny
a technologie SmartControl Premium
se stala nepouzitelnou, co mam délat?
Odp.: Restartujte pocitac a zjistéte, zda
technologie SmartControl Premium
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Premium, aby bylo
zaji§téno, Ze je nainstalovan spravny
ovladac.

Ot.2: Technologie SmartControl Premium
drive dobre fungovala, ale nyni
nefunguje, co mam délat?

Odp.: Pokud byly provedena nésledujici kroky,
bude pravdépodobné nutné znovu

nainstalovat ovlada¢ monitoru.
* Poutzijte jiny graficky adaptér videa
*  Zaktualizujte ovladac videa
+ Cinnosti na operacnim systému, napiiklad
aktualizace nebo oprava
*  Spust'te sluzbu Aktualizace Windows a
zaktualizujte ovlada¢ monitoru a/nebo videa



Ot 3:

Odp.:

Ot. 4.

Odp.:

Operacni systém Windows byl zaveden,
kdyz byl monitor vypnuty nebo odpojeny.
Chcete-li ziskat dalsi informace, kliknéte
pravym tlacitkem mysi na My Computer
(Tento pocitac) a kliknéte na Properties
(Vlastnosti) -> Hardware (Hardware) ->
Device Manager (Spravce zarizen).

Pokud je pod polozkou Monitor uvedeno
,,Plug and Play Monitor” (Monitor Plug
and Play), je tfeba provést novou instalaci.
Jednoduse odeberte a znovu nainstalujte
SmartControl Premium .

Kdyz po nainstalovani SmartControl
Premium kliknu na kartu SmartControl
Premium, ani po chvili se nic nezobrazi
nebo se zobrazi zprava o chybé, co se
stalo?

V&3 graficky adaptér pravdépodobné
neni kompatibilni s technologif
SmartControl Premium. Pokud je vas
graficky adaptér mezi vy3e uvedenymi
znackami, zkuste stdhnout nejaktudingjsf
ovlada¢ grafického adaptéru z webovych
stranek prislusného vyrobce. Nainstalujte
ovladac. Odeberte a znovu nainstalujte
SmartControl Premium.

Pokud presto nefunguje, graficky
adaptér bohuzel nenf podporovédn. Na
webovém serveru spolecnosti Philips
zjistéte, zda je k dispozici zaktualizovany
ovlada¢ SmartControl Premium.

Po kliknuti na Product Information
(Informace o produktu) se zobrazi
pouze castecné informace, co se stalo?

Pravdépodobné neméte k dispozici
nejaktudlngjsi verzi ovladace adaptéru
grafické karty, kterd pIné podporuje
rozhrani DDC/CI. Pokuste se stédhnout
nejaktudlnéjsi ovladac grafického
adaptéru z webovych stranek
prislusného vyrobce. Nainstalujte
ovladac. Odeberte a znovu nainstalujte
SmartControl Premium.

Ot.5:

Odp.:

Attention

Theft mode enabled

Zapomnél jsem sviij kéd PIN pro
funkci Theft Deterrence (zabezpeceni
proti kradezi). Co mam délat?

Servisn( stredisko Philips ma pravo
z4dat legitimn( identifikaci a ovérenf pro
Zjistén( vlastnictvi monitoru.

9.3 Obecné casté dotazy

Oot.1:

Odp.:

Co mam udélat, kdyz se po instalaci
monitoru na obrazovce zobrazi zprava
,»Cannot display this video mode*
(Tento rezim videa nelze zobrazit)?

Doporucené rozliseni pro tento
monitor: 1920 x 1080 pri 60 Hz.

Odpojte viechny kabely, potom pripojte
pocfta¢ k monitoru, ktery jste pouzili
predtim.

V nabidce Start operac¢niho systému
Windows vyberte Settings/Control Panel
(Nastaveni/Ovladaci panely).V okné
Control Panel (Ovlddacf panely) vyberte
ikonu Display (Zobrazeni). Na panelu
Display Control (Ovladani zobrazen)
vyberte kartu ,Settings” (Nastaven(). Na
karté nastaveni v poli oznaceném ,,desktop
area" (pracovni plocha) presurite posuvnik
na 1920 x 1080 obrazovych bodu.

Klepnéte na ,, Advanced Properties"
(Pokrocilé), nastavte polozku Obnovovac(
frekvence na 60 Hz a potom klepnéte na
OK.

Restartujte pocitac a zopakovanim kroku 2
a 3 ovérte, zda je pocitac nastaven na 1920
x 1080 pri 60 Hz.

Vypnéte pocitac, odpojte stary monitor a
znowvu pripojte monitor LCD Philips.

Zapnéte monitor a potom zapnéte pocitac.



Ot. 2:

Odp.:

Ot 3:

Odp.:

Ot. 4
Odp.:

Ot.5:

Odp.:

Ot.6:

Odp.:

Jaka je doporuéena obnovovaci
frekvence monitoru LCD?

Doporucena obnovovac( frekvence LCD
monitoru je 60 Hz.V pripadé jakéhokoli
ruseni na obrazovce ji mizete nastavit
na 75 Hz a uvidite, zda ruseni zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat ovladace
(:inf a .icm)?

Jednd se o soubory ovladace monitoru.
Pri instalaci ovladacd postupuijte podle
pokynl v uzivatelské prirucce. Pri prvnf
instalaci bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynt a
vlozte ( doprovodny disk CD-ROM),
ktery je soucdsti této sady. Ovladace
monitoru (soubory .inf a .icm) budou
nainstalovdny automaticky.

Jak mam upravit rozliSeni?

Dostupnd rozliseni uréuje grafickd karta/
ovladac grafiky a monitor. Pozadované
rozlideni mizete vybrat v casti Control
Panel (Ovlddac( panely) systému
Windows® v ésti ,,Display properties
(Vlastnosti zobrazen).

Co kdyz se béhem nastaveni monitoru
ztratim prostrednictvim nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,Reset” (Obnovit)
obnovte viechna pvodni nastaven(
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmérnym dderim a
chranit jej pred ostrymi nebo tupymi
predméty. Pri manipulaci s monitorem
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ot.7:
Odp.:

Ot.8:
Odp.:

nevyvijejte na povrch panelu zadny tlak
ani sflu. Mohlo by to negativné ovlivnit
vade zdru¢ni podminky.

Jak Ize Cistit povrch monitoru LCD?
Pro b&zné cisténi pouZijte Cisty a mekky
hadrik. Pro dikladné cisténi pouzijte
izopropyl alkohol. Nepouzivejte zadna
jind rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

Lze ménit nastaveni barev monitoru?

Ano, nastaveni barev mdzete zménit
prostrednictvim nabidky OSD podle
ndsledujicich krokd:

e Stisknutim tlacitka ,,OK" zobrazte nabidku
OSD.

«  Stisknutim tlagitka ,,Down Arrow" (Sipka
dold) vyberte volbu ,,Color" (Barva)
a stisknutim tlacitka ,,OK" prejdéte
na nastaven( barev. K dispozici jsou tfi
nastaven( (viz nize).

1.

Color Temperature (Barevna teplota):
k dispozici je Sest nastaveni: 5000K,
6500K, 7500K, 8200K, 9300K a 11500K.
Pri nastaven( v rozsahu 5000K vypadajf
barvy na panelu ,teplé” s cervenobilym
barevnym ténem, zatimco pfi nastavenf
teploty 11500K vypadajf barvy na
panelu ,,studené” s modrobilym
barevnym ténem.

sRGB: jde o standard pro zajistén(
spravného podéni barev na rdznych
zafizenich (napr’. digitdIni fotoapardty,
monitory, tiskdrny, skenery atd.)

User Define (UzZivatelské): uzivatel

si mdze zvolit vlastni nastaven barev
upravenim cervené, zelené a modré
slozky.

€& Poznimka

Meren( svétla barvy, které vyzaruje predmét pri

zahrfvani. Toto méreni je vyjddieno v absolutnim

meéritku (stupné Kelvina). Nizsi teploty Kelvina,
napfiklad 2004 K| jsou Cervené; vyssi teploty, jako



napfiklad 9300 K, jsou modré. Neutrdlnf teplota
je bild pri 6504 K.

Ot.9: Lze pfipojit tento monitor LCD k
libovolnému pocitaci, pracovni stanici
nebo pocitaci Mac?

Odp.:  Ano.Vsechny monitory LCD Philips
jsou pIné kompatibilnf se standardnimi
pocftadi, pocftaci Mac a pracovnimi
stanicemi. Pro pfipojeni monitoru
k systému Mac mUze byt zapotrebi
kabelovy adaptér. Dalsf informace vdm

vy

Philips.

Ot. 10: Jsou monitory Philips LCD vybaveny
technologii Plug-and-Play?

Odp.:  Ano, tyto monitory jsou kompatibilni's
technologii Plug-and-Play v opera¢nim
systému Windows 7/Vista/XP/NT, Mac
OSX, Linux

Ot. 11: Co znamena Ipéni obrazu, vypaleni
obrazu, dosvit nebo ,,duch*
v souvislosti s panely LCD?

Odp.: Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu
mUze zpUsobit , vypaleni** obrazovky,
rovnéz zndmé jako ,,dosvit" nebo
,,zobrazenf duchd., Vypdlen(,, ,dosvit"
nebo , zobrazenf duchl" je dobre
zndmy jev u technologie panell LCD.

V mnoha pripadech "vypdlenf", "dosvit"
nebo "zobrazeni duchd" postupné zmizf
po urcité dobé mimo provoz.

Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky obsah,
vzdy aktivujte aplikaci pro pravidelnou
obnovu obrazovky.

) Vystraha

Pokud neaktivujete spofi¢ obrazovky nebo
aplikaci, kterd pravidelné obménuje obsah
zobrazeni, mize dojit k vdznému , vypéleni,
,dosvitu" nebo ,,zobrazenf duchd*, a toto
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naruseni obrazu jiz nelze odstranit. Na vyse
uvedené poskozen( se nevztahuje zdruka.

Ot. 12: Proc se na displeji nezobrazuje ostry

Odp.:

text a pro¢ maji zobrazené znaky
zubaté okraje?

V&3 LCD monitor nejlépe pracuje pri
svém nativnim rozlisenf 1920 x 1080
pri 60 Hz. PouZivejte toto rozliseni pro
dosazeni optimalntho zobrazen.
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